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NEW QUESTION 1

Refer to the exhibit. Users report that when they dial to Cisco Unity Connection from an external network, they cannot enter any digits. Assuming only in-band
DTMF is supported, what is a reason for this malfunction?

A. The negotiated RTP port is outside of the range described by RFC, so inband DTMFs do not work.
B. There is SIP Delayed Offe
C. DTMF is supported only in Early Offer.
D. The rtpmap:0 value for the negotiated codec is marking DTMF as inactive.
E. No DTMF is negotiated.

Answer: D

NEW QUESTION 2
The administrator of ABC company is troubleshooting a one-way audio issue for a call that uses H.323 protocol (slow-start mode). The administrator requests that
you provide the IP and port information of the Real-Time Transport Protocol traffic that had the one-way audio call.
You gather the H.225 and H.245 messages for one of the one-way audio calls. Where can you find the RTP IP and port information for both sides? (Note: This call
flow has not invoked any media resources like MTP or transcoders).

A. H.245 Terminal Capability Set
B. H.245 Open Logical Channel
C. H.225 Connect
D. H.245 Open Logical Channel Ack

Answer: B

NEW QUESTION 3
Which two extended capabilities must be configured on dial peers for fast start-to-early media scenarios (H.323 to SIP interworking)? (Choose two.)

A. DTMF
B. BFCP
C. VIDEO
D. FAX
E. AUDIO

Answer: AB

NEW QUESTION 4
Which section under the Real-Time Monitoring Tool allows for reviewing the call flow and signaling for a SIP call in real time?

A. Analysis Manager > Inventory > Trace File Repositories
B. System > Tools > Trace and Log Central
C. Voice/Video > Session Trace Log View > Real Time Data
D. Voice/Video > Session Trace Log View > Open From Local Disk

Answer: C

NEW QUESTION 5
A company has an SRST gateway running an IOS XE image. The company plans to enable the IPv6 addressing companywide. To enable the IPv6 in a unified
SRST gateway to support SIP phones, what are two supported supplementary features for an IPv6 fallback scenario? (Choose two.)

A. three-way conference
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B. secure SIP lines
C. T.38 fax relay
D. transcoding
E. SIP trunk

Answer: AC

NEW QUESTION 6
You see the voice register pool 1 command in your Cisco Unified Communications Manager Express configuration. Which configuration is occurring in this
section?

A. configuration for a single SIP phone
B. configuration items common for all SIP phones
C. configuration for a pool of SIP phones (similar to device pool on Cisco Unified Communications Manager)
D. configuration for SIP registrar service

Answer: C

NEW QUESTION 7
Which top-level IOS command is needed to begin the configuration of a Cisco Unified Communications Manager Express gateway to enable phones to be
registered via SIP?

A. allow-connections sip to sip
B. voice service voip
C. voice register global
D. voice register dn

Answer: C

NEW QUESTION 8
For s SIP to SIP call flow, when does Cisco Unified Border Element require transcoding resources for DTMF?

A. interworking between an OOB method and RFC2833 for flow-around calls
B. interworking between h245-signal and rtp-nte
C. interworking between an OOB method and RFC2833 for flow-through calls
D. interworking between h245-alpha numeric and sip-kpml

Answer: A

NEW QUESTION 9
Which IOS command creates a SIP- enabled dial peer?

A. voice dial-peer 20 sip
B. dial-peer voice 20 voip
C. dial-peer voice 20 pots
D. dial peer voice 20 sip

Answer: B

NEW QUESTION 10
An engineer must route all SIP calls in the form of <user>@example.com to the SIP trunk gateway corporate local. Which two SIP route patterns can be used to
accomplish this task? (Choose two.)

A. example.com@gateway.corporate.local
B. *@example.com
C. gateway.corporate.local
D. example.com
E. *.*

Answer: BE

NEW QUESTION 10
Which two statements are correct with respect to the Client Matter Code setting in the route pattern configuration? (Choose two.)

A. The Client Matter Code feature does not support overlap sending because the Cisco Unified CM cannot determine when to prompt the user for the code.
B. If you check the Allow Overlap Sending check box, the Require Client Matter Code check box becomes disabled.
C. If you check the Allow Overlap Sending check box, you can also check the Require Client Matter Code check box.
D. The Client Matter Code feature does support overlap sending because the Cisco Unified Communications Manager can determine when to prompt the user for
the code.
E. The Client Matter Code has the option to configure Authorization Level such as in the Forced Authorization Code.

Answer: AB

NEW QUESTION 11
A network engineer designs a new dial plan and wants to block a certain range of numbers (8135100 through 8135105). What is the most specific route pattern
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that can be configured to block only the numbers in this range?

A. 813510[012345]
B. 813510[12345]
C. 813510[^0-5]
D. 81XXXXX

Answer: A

NEW QUESTION 12
Refer to the exhibit. An engineer configures Cisco Unified Border Element to connect the enterprise VoIP network with a SIP telephony provider. Calls are not
working in either direction. What must be configured in the dial peer 1 to fix the issue?

A. address 555 ……..
B. codec g729
C. session-protocol sipv2
D. incoming called number 555…….

Answer: D

NEW QUESTION 16
After configuring a Cisco CallManager Express with Cisco Unity Express, inbound calls from the PSTN SIP trunk receive a ring tone for 20 seconds and then a
busy signal instead of voicemail. Which configuration fixes this problem?

A. Router(config)# voice service voipRouter(conf-voi-serv)#allow-connections h323 to h323
B. Router(config)#dial-peer voice 2 voipRouter(config-dial-peer)#no vad
C. Router(config)# voice service voipRouter(conf-voi-serv)#allow-connections voice-mail mod
D. Router(config)# voice service voipRouter(conf-voi-serv)#no supplementary-service sip moved-temporarily

Answer: A

NEW QUESTION 21
In Cisco Unified Communications Manager, which tool do you use to check SIP traces?

A. MTP
B. CCSIP
C. RTMT
D. OS Administration Page

Answer: C

NEW QUESTION 23
If all patterns below are configured in Cisco Unified Communications Manager which would be used when dialing the pattern “123”?

A. 12!
B. 12X (urgent priority set)
C. 1XX (urgent Priority Set)
D. 12[2-5]

Answer: B

NEW QUESTION 26
Which configuration must an administrator perform to display Translation Pattern operations in Cisco Unified Communications Manager SDL traces?

A. Enable the Detailed Call Analysis option under Enterprise Parameters for Unified CM.
B. Set up the Digit Analysis Complexity in Service Parameters for Cisco Unified CM to TranslationAndAlternatePatternAnalysis.
C. Check the Translation Patterns Analysis check box in Micro Traces on the Cisco Unified CM Serviceability page.
D. By default, the Translation Patterns operations are printed in SDL traces, so no additional configuration is necessary.

Answer: A

NEW QUESTION 31
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Refer to the exhibit. An administrator is troubleshooting a situation where a call placed from a phone registered to Cisco Unified Communications Manager does
not complete. The administrator wants to use the Dialed Number Analyzer on Cisco Unified CM to check which translation pattern the call is matching. However,
when logging in to Cisco Unified Serviceability there is no option for Dialed Number Analyzer under the tool menu. Which two steps must be performed to resolve
this issue? (Choose two.)

A. Restart the subscriber
B. Activate the Cisco Extended Functions service.
C. Activate the Cisco CallManager service.
D. Activate the Cisco Dialed Number Analyzer service.
E. Activate the Cisco Dialed Number Analyzer Server service.

Answer: DE

NEW QUESTION 33
In Cisco Unified Communications Manager globalized call routing is implemented and must confirm that it is correctly implemented without making a call. Which
tool do you use for verification?

A. Dialed Number Analyzer
B. Real-Time Monitoring Tool
C. SDI trace
D. SDL trace

Answer: A

NEW QUESTION 34
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Refer to the exhibit. Within the North American Numbering Plan, gateways located in Ottawa, Canada and marked as “YOW” are assigned to the Calling Party
Transformation CSS NANP_CgPTP, which contains partition NANP_calling_xforms. What is the calling-party number and the numbering type if the calling user
+1613-555-1234 dials the number?

A. calling number 613-555-1234 and numbering type “subscriber”
B. calling number 011-1-613-555-1234 and numbering type “subscriber”
C. calling number 011613-555-1234 and numbering type “international”
D. calling number 613-555-1234 and numbering type “national”

Answer: D

NEW QUESTION 35
Where on Cisco Unified Communications Manager do you configure the standard local route group for a group of devices?

A. System > Location Info
B. Call Routing > Route/Hunt > Local Route Group Names
C. System > Device Pool
D. Call Routing > Emergency Location > Emergency Location (ELIN) Groups

Answer: B

NEW QUESTION 38
Which two types of distribution algorithm are within a line group? (Choose two.)

A. random
B. circular
C. highest preference
D. top down
E. bottom up

Answer: BD

NEW QUESTION 39
When locations-based Call Admission Control denies the call, which two masks can AAR apply when routing the call through the PSTN? (Choose two.)

A. AAR destination mask
B. called party transform mask
C. external phone number mask
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D. +E.164 alternate number mask
E. enterrise alternate number mask

Answer: AC

NEW QUESTION 41
An administrator is configuring a cluster for ILS and wants to limit the amount of entities that Cisco Unified Communications Manager can write to the database for
data that is learned through ILS. Which service parameter is used to adjust this limit?

A. ILS Max Number of Learned Objects in Database
B. ILS Active Learned Object Upper Limit
C. Global Data Service Parameter Limit
D. Imported Dial Plan Replication Database Object Lower Limit

Answer: A

NEW QUESTION 43
Which configuration element of a hunt group allows for changing Calling Party Transformations settings?

A. line group
B. hunt pilot
C. route group
D. hunt list

Answer: B

NEW QUESTION 44
Which two types of authentication are supported for the configuration of Intercluster Lookup Service? (Choose two.)

A. TokenID
B. username and secret key
C. TLS certificates
D. passwords
E. FQDN of the servers defined in DNS

Answer: CD

NEW QUESTION 48
Which two configuration parameters are prerequisites to set Native Call Queuing on Cisco Unified Communications Manager? (Choose two.)

A. Cisco IP Voice Media Streaming Service must be activated on at least one node in the cluster.
B. A unicast music on hold audio source must be configured.
C. Cisco RIS data collector service must be running on the same server as the Cisco CallManager service.
D. The maximum number of callers allowed in queue must be 10.
E. The phone button template must have the Queue Status Softkey configured.

Answer: AC

NEW QUESTION 53
Configure Call Queuing in Cisco Unified Communications Manager. Where do you set the maximum number of callers in the queue?

A. in the telephony service configuration
B. in the queuing configuration
C. in Cisco Unified CM Enterprise Parameters
D. in Cisco Unified CM Service Parameters

Answer: B

NEW QUESTION 57
A user reports that when they attempt to log out from the Cisco Extension Mobility service by pressing the Services button, they cannot log out. What is the most
likely cause of this issue?

A. The Cisco Extension Mobility service has not been configured on the phone.
B. There might be a significant delay between the button being pressed and the Cisco Extension Mobility service recognizing i
C. It would be best to check network latency.
D. The user device profile has not been assigned to the user.
E. The user device profile is not subscribed to the Cisco Extension Mobility service.

Answer: D

NEW QUESTION 62
......
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